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FeatureCAM est un logiciel de CFAO qui automatise l'usinage et 
minimise les temps de programmation pour les pièces sur des 
fraiseuses, des tours et des machines d'électro-érosion à fil.  

 La fonctionnalité disponible dépend de la version que vous 
avez licenciée.  

FeatureCAM génère des parcours d'outils en se basant sur les 
features de la pièce et sélectionne automatiquement les outils 
appropriés, détermine les passes d'ébauche et de finition et calcule 
les avances et les vitesses.  

Ce guide de démarrage fournit des instructions pas à pas qui 
mettent en avant certaines fonctions de ce logiciel polyvalent. 
FeatureCAM est très facile d'utilisation et ne requiert pas de 
compétences informatiques spécialisées.  

 

Mise en route de 
FeatureCAM 
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Démarrage de FeatureCAM pour la 
première fois 

1 Depuis le menu Démarrer, sélectionner Tous les programmes > 
Autodesk, Inc > FeatureCAM.  

 Vous pouvez également démarrer le programme en 

double-cliquant sur l'icône de FeatureCAM  sur votre 
bureau.  

La première fois que vous démarrez FeatureCAM, il lance un 
programme pour créer la base de données d'outillage et de 
matières.  

2 Cliquer sur OK pour commencer la configuration. Cela affiche la 
boite de dialogue Configuration d'outillage et de matières.  

 
3 Pour créer une base de données locale, sélectionner PC local.  

Si vous voulez que plusieurs ordinateurs partagent les mêmes 
informations d'outillage et de matières :  

a Sélectionner Sur un PC accessible en réseau.  

b Cliquer sur le bouton Parcourir et utiliser la boite de dialogue 
Emplacement de la base de données pour sélectionner le dossier 
où se situe la base de données.  
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 Vous devez d'abord créer un dossier de base de données 
sur votre réseau, puis copier une base de données MDB 
vide à partir du CD-ROM de FeatureCAM à cet endroit. La 
base de données par défaut est créée par MS-Access et 
devrait être accessible en utilisant le pilote MS Jet 
database. Vous pouvez utiliser un type de base de données 
différent, tel que MS SQL Server. Pour de plus amples 
informations, se référer à l'aide en ligne.  

4 Cliquer sur Suivant. 

5 Choisir les outils à charger :  

 
Pouces - charge uniquement les outils en pouces.  

Métrique - charge uniquement les outils métriques.  

Les deux - charge les outils en pouces et métriques.  

6 Cliquer sur Suivant. 

7 Si vous choisissez de charger les deux types d'outils, il vous est 
demandé quel type d'outils vous utilisez le plus souvent. 
Sélectionner Pouces ou Métrique et cliquer sur Suivant.  

8 Cliquer sur Terminer pour initialiser la base de données.  
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 La base de données d'outillage spécifie l'ensemble d'outils 
utilisé par FeatureCAM pour effectuer les opérations de 
fabrication. Pour de meilleurs résultats, utiliser le gestionnaire 
d'outil (disponible depuis le menu Fabrication) pour 
personnaliser la base de données pour refléter les outils de 
votre atelier.  
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Création d'un nouveau fichier 
Démarrer FeatureCAM affiche l'assistant de nouveau document pièce. 

 
1 Si l'assistant de nouveau document pièce n'est pas affiché, 

sélectionner l'option de menu Fichier > Assistant de pièce. 

2 Sélectionner Nouveau fichier dans l'assistant de nouveau 
document pièce puis cliquer sur le bouton Suivant. 

3 Sélectionner le type de fichier pièce que vous voulez créer.  

 
4 Sélectionner l'unité de mesure (Pouces ou Millimètres).  
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 Vous pouvez changer les unités de dimensions par défaut 
plus tard, en sélectionnant Options > Options de fichier 
depuis le menu.  

5 Cliquer sur Terminer. 
 

Interface de FeatureCAM 
L'interface de FeatureCAM contient un nombre d'éléments 
traditionnels de Windows, tels que les barres d'outils, les boites de 
dialogue, les menus contextuels et les assistants.  

 
 Barre de titre  Fenêtre Boite à outils avec l'arbre de 

construction, les étapes et le navigateur.  

 Barre de menu  Fenêtre de résultats 

 Barre d'outils  Barre d'assistance — Les instructions 
étape-par-étape sont affichées sur la barre 
d'assistance.  

 Fenêtre graphique  Barre d'édition de feature/géométrie 

 ViewCube  Barre d'état 
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La barre de titre affiche le type de repère de pièce entre 
parenthèses, dans ce cas (Fraisage) et le nom de votre fichier pièce 
entre crochets, dans ce cas [FM1]. Quand vous avez des 
changements non-enregistrés dans votre fichier pièce, une 
astérisque (*) est affichée à côté de son nom.  

Comme avec d'autres programmes de Windows, vous pouvez dire à 
FeatureCAM quoi faire de différentes façons :  

 Sélectionner un bouton sur une barre d'outils,  

 Sélectionner une option depuis un menu,  

 Sélectionner une option depuis un menu contextuel,  

 Appuyer sur un raccourci clavier.  

 Quand vous maîtrisez FeatureCAM, essayez de combiner 
plusieurs méthodes d'utilisation de commandes pour travailler 
plus rapidement.  

Cliquer-droit afficher un menu contextuel. Le menu varie selon où 
vous êtes dans le programme. Le menu contient des commandes 
communes et des fonctions qui sont utiles dans cette zone.  

 

Obtenir de l'aide 
FeatureCAM fournit une multitude de façons d'obtenir de l'aide. 
L'aide contextuelle affiche de l'aide pour la tâche actuelle. Vous 
pouvez également vous référer aux nombreux exemples dans le 
dossier Examples, situé dans le répertoire racine de FeatureCAM. Au 
final, si vous ne parvenez pas à trouver une réponse à votre 
question, vous pouvez visiter notre site internet ou contacter notre 
support technique.  

Aide en ligne 

La documentation d'aide en ligne est votre source primaire 
d'informations pour des renseignements techniques en profondeur à 
propos de FeatureCAM. Pour y accéder, sélectionner l'option de 
menu Aide > Contenu ou cliquer sur  sur la barre d'outils 
standard.  

Aide contextuelle 

Vous pouvez utiliser une des méthodes suivantes pour obtenir de 
l'aide sur la tâche actuelle :  

 Quelques commandes affichent automatiquement l'aide dans la 
barre d'assistance.  
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 Survoler une icône de barre d'outils avec le curseur affiche une 
brève description.  

 
 Appuyer sur la touche F1 affiche la page d'aide pertinente.  

 La plupart des boites de dialogue de FeatureCAM ont un bouton 
d'aide. Cliquer sur ce bouton affiche la page d'aide pertinente.  

 Cliquer sur le bouton Aide contextuelle    sur la barre d'outils. 
Quand le curseur s'est changé en point d'interrogation (?), 
cliquer sur un élément de menu, un bouton ou une boite de 
dialogue pour plus d'informations.  

Liens 

Il y a des liens supplémentaires dans le menu Aide pour vérifier sur 
internet pour plus d'informations sur FeatureCAM.  

A propos de 

Sélectionner l'option de menu Aide > A propos de pour ouvrir une 
boite de dialogue qui affiche la version, le build, la licence et les 
informations de copyright de votre installation de FeatureCAM. Vous 
pouvez également utiliser la boite de dialogue pour ouvrir le 
gestionnaire de licence et pour afficher les marques déposées et les 
crédits pour les logiciels tiers utilisés par FeatureCAM.  
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Ce didacticiel vous montre comment créer de simples features 2,5D, 
générer les parcours d'outils et extraire le parcours utilisé pour 
usiner la pièce. 

Pour utiliser l'exemple de fraisage 2,5D, démarrer FeatureCAM (voir 
"Démarrage de FeatureCAM pour la première fois" sur la page 2), 
créer un nouveau fichier (voir "Création d'un nouveau fichier" sur la 
page 5), puis suivre ces étapes :  

1 Création du brut (voir "Définition du brut (Fraisage 2,5D)" sur la 
page 10). 

2 Création des features (voir "Création des features (Fraisage 
2,5D)" sur la page 10). 

3 Affichage de la pièce (voir "Affichage de la pièce (Fraisage 2,5D)" 
sur la page 14).  

4 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (Fraisage 2,5D)" sur la page 15).  

5 Création de la documentation pièce (voir "Documentation de 
pièce (Fraisage 2,5D)" sur la page 21).  

6 Contrôle de l'automatisation (voir "Contrôle des stratégies" sur la 
page 22).  

7 Changement du post-processeur (voir "Changement de 
post-processeur" sur la page 27).  

8 Génération du code CN (voir "Génération du code CN (Fraisage 
2,5D)" sur la page 24).  

9 Affectation des outils (sur la page 26). 

10 Enregistrement du code CN (sur la page 27).  
 

Introduction au fraisage 
2,5D 
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Définition du brut (Fraisage 2,5D) 
Le brut est la matière initiale, avec laquelle vous usinez votre pièce. 
Quand vous créez une nouvelle pièce, la page Dimension de 
l'assistant Brut s'ouvre. Elle vous permet de déterminer la forme et 
les dimensions du brut, la matière du brut, l'origine du programme 
et le système de coordonnées pour la modélisation. 

1 Dans la page Dimensions de l'assistant de brut : 

 
a Entrer une épaisseur de 25mm. 

b Entrer une largeur de 100mm. 

c Entrer une longueur de 120mm. 

d Cliquer sur Terminer 

2 Cliquer sur OK pour accepter les valeurs de l'assistant de brut. 
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Création des features (Fraisage 2,5D) 
Cette étape montre comment créer un perçage et une poche 
rectangulaire. 

Unités impériales Unités métriques 

1 Créer une feature de perçage. 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 

b Dans l'assistant de nouvelle feature, sélectionner Perçage dans 
la section Depuis dimensions, et cliquer sur Suivant. 

c Entrer un diamètre de 12mm et cliquer sur Suivant. 

d Entrer l'emplacement du centre du perçage X 25mm et Y 
25mm, et cliquer sur Suivant. 

Ceci affiche la page Stratégies. Cette page contrôle les types 
d'opérations qui permette de séparer la feature. Les 
opérations par défaut pour le perçage d'un trou, sont de 
repérer et de percer le trou. Si le perçage comporte un 
chanfrein, nous allons usiner le chanfrein avec l'opération de 
pointage par défaut. 

e Accepter les réglages de stratégie par défaut en cliquant sur 
Suivant. 
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La page Opérations montre un sommaire des opérations pour 
usiner la feature, les outils sélectionnés automatiquement et 
les avances et vitesses. 

 
Depuis le bouton Terminer du menu, sélectionner l'option 
Terminer . 

 
2 Création d'une feature de poche rectangulaire. 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 

b Dans l'assistant de nouvelle feature, sélectionner Depuis 
dimensions dans la section Poche rectangulaire, et cliquer sur 
Suivant. 

c Accepter les dimensions par défaut en cliquant sur Suivant. 

d Entrer l'emplacement du centre de la poche X 19mm, et Y 
63,5mm, et Z 0mm, et cliquer sur Suivant. 
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La page Stratégies montre que les opérations d'ébauche et de 
finition ont été créées. 

 
e Cliquer sur le bouton Terminer. 

3 Utiliser l'étape Features  pour créer un deuxième perçage 
avec un diamètre de 12mm, situé à X=100mm et Y=76mm. 

4 Utiliser l'étape Features  pour créer une autre poche 
rectangulaire avec les mêmes dimensions que la première, mais 
positionnée à X=63,5mm, Y=12mm. 

 
5 Sélectionner Fichier > Enregistrer, et enregistrer votre pièce sous 

milling.fm. 
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Affichage de la pièce (Fraisage 2,5D) 
Pour regarder la pièce dans une orientation différente vous pouvez 
sélectionner une des vues prédéfinies. Ces options sont disponibles 
depuis la barre d'outils Standard : 

 
1 Pour changer la vue par une vue isométrique, cliquer sur le 

bouton Isométrique  de la barre d'outils Standard. 

 

2 Pour passer en vue de face, utiliser le bouton Vue principale . 

 

Cliquer sur le bouton Face . 

 

3 Cliquer sur Isométrique  pour revenir à la vue isométrique 
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Simulation du parcours d'outils 
(Fraisage 2,5D) 

Maintenant que vous avez créé des features, FeatureCAM va 
automatiquement : 

 sélectionner les outils et les opérations les plus appropriés,  

 recommander les techniques d'usinage,  

 calculer les vitesses et les avances,  

 générer les parcours d'outils et créer les codes CN. 

Pour voir le parcours simulé : 

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

 

2 Cliquer sur le bouton Simulation 3D , et ensuite cliquer sur le 
bouton Play  pour démarrer la simulation. Si la boite de 
dialogue Options de tri automatique apparaît, cliquer sur OK pour 
la fermer. Ceci accepte les options de tri par défaut. 

Ceci affiche un rendu 3D du processus d'usinage. 
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 Si tous les outils sont affiché en gris dans la simulation, 
sélectionner Options > Simulation > Générale depuis le menu, 
et sélectionner l'option Couleurs d'outil, enfin cliquer que OK 
pour fermer la boite de dialogue. Cela affiche les outils en 
différentes couleurs, vous pouvez donc voir quelles features 
sont usinées par chaque outil.  

Cliquer sur le bouton Play  dans la barre d'outils 
Simulation pour voir les changements. 

3 Cliquer sur Jusqu'à l'opération suivante . Ceci affiche 
l'opération de pointage. 

 
4 Répéter l'étape 3 pour afficher chaque opération tant que vous 

n'avez pas completé la simulation. 

5 Cliquer sur Ejecter . Ceci efface la barre d'outils de simulation. 
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Tri des opérations de fabrication 
L'onglet d'outil Liste opé., dans la fenêtre des résultats, affiche 
toutes les opérations qui sont converties en features. Un signe 
jaune d'avertissement  à côté d'une opération indique un 
problème potentiel sur cette opération. Dans ce cas, si vous voyez 
des avertissements ignorez-les. 

 
Cette section examine : 

 Les options de tri automatique. (voir "Tri automatique des 
opérations" sur la page 17) 

 Les options de tri manuel. (voir "Options de tri manuel" sur la 
page 19) 

 

Tri automatique des opérations 
Vous pouvez contrôler le tri automatique des opérations en utilisant 
soit des règles, soit des templates d'opération. Le tutoriel de 
tournage se penche sur les templates d'opération (voir "Triage des 
opérations de fabrication (Tournage)" sur la page 46).  

1 Sélectionner l'option Tri automatique dans l'onglet Liste opé. Cela 
s'assure que les règles de tri automatique soient appliquées aux 
opérations.  

2 Changer le tri automatique pour grouper les opérations qui 
utilisent le même outil.  

a Cliquer sur le bouton des options de tri  .  
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b Dans la boite de dialogue Options de tri automatique, 
sélectionner Minimiser les changements d'outils, désélectionner 
tout le reste et cliquer sur OK.  

 
3 Simuler la pièce.  

a Sélectionner l'étape Parcours d'outil  depuis le panneau 
Etapes.  

Cela affiche la barre d'outils de simulation.  

b Cliquer sur le bouton Simulation 3D .  

c Cliquer sur le bouton Play .  

Si la boite de dialogue Options de tri automatique apparaît, 
cliquer sur OK pour la fermer. Remarquez que la simulation 
effectue d'abord tous les pointages, puis les perçages et enfin 
l'ébauche et la finition pour les poches.  

d Cliquer sur le bouton Stop    quand la simulation est 
terminée pour quitter le mode simulation.  

4 Changer le tri automatique pour déplacer les opérations de 
finition à la fin de la liste.  

a Cliquer sur le bouton des options de tri  . 

b Dans la boite de dialogue Options de tri automatique, 
sélectionner Passes de finition en dernier, désélectionner tout le 
reste et cliquer sur OK.  

 
Ceci change l'ordre des opérations dans la liste des opérations.  
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5 Simuler la pièce. 

a Sur la barre d'outils de simulation, cliquer sur Play .  

Les coupes de finition pour les deux poches sont maintenant 
usinées en dernier.  

b Cliquer sur Stop  quand la simulation est terminée.  

6 Changer le tri automatique pour faire correspondre l'ordre des 
features dans le volet Arbre de construction.  

a Cliquer sur le bouton des options de tri  . 

b Désélectionner tout et cliquer sur OK.  

c Ouvrir le volet Arbre de construction en cliquant sur 
. L'arbre de construction contient 

tous les repères et les features que vous avez créés.  

d Cliquer sur l'élément poche_rect2 sur le noeud Repère1 et le 
faire glisser au-dessus de perçage2.  

 
7 Simuler la pièce. 

a Sur la barre d'outils de simulation, cliquer sur Play . 

La seconde poche est usinée comme étant la seconde feature.  

b Cliquer sur Stop . 
 

Options de tri manuel 
Le tri automatique des opérations détermine l'odre par des règles 
définies. Vous pouvez aussi spécifier un ordre d'opérations 
manuellement. 

1 Sélectionner l'option Tri manuel  dans l'onglet Liste Opé. 
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2 Dans la boite de dialogue Tri fixe des opérations, sélectionner Ne 
plus afficher ce message, et cliquer sur OK. 

 
3 Sélectionner l'opération pointage du percage2 à partir de la liste 

et déplacer le devant l'opération perçage du percage1. 

 
4 Simuler la pièce. 

a Dans la barre d'outils Simulation, cliquer sur Play . La 
simulation réalise les opérations dans un nouvel ordre. 

b Cliquer sur Stop   quand la simulation est terminée. 

5 En sélectionnant Ordre automatique pour retourner au tri 
automatique. 

6 Cliquer sur OK pour fermer la boite de dialogue  de Opération tri 
automatique. 

 Si vous voulez effacer la simulation et supprimer la barre 
d'outils Simulation, cliquer sur Ejecter . 
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Documentation de pièce (Fraisage 
2,5D) 

Aussi bien que pour la simulation d'une pièce, la simulation génère 
aussi des listes complètes des outils et des opérations.  Les outils 
sélectionnés sont basé sur votre base de données d'outil.  Vous 
pouvez imprimer cette liste pour réaliser un contrôle par 
l'opérateur. 

1 Cliquer sur l'onglet Détails dans la fenêtre Résultats pour afficher 
le panneau Opérations de fabrication. 
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2 Sélectionner l'option Liste d'outils au dessus de l'onglet Détails 
pour afficher le panneau Résumé des outils d'usinage. Il contient 
tous les outils utilisés pour créer la pièce, en se basant sur la 
bibliothèque que vous avez sélectionnée. 

 

 Vous pouvez imprimer cette documentation avec l'option 
menu Fichier > Imprimer. 
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Contrôle des stratégies 
Vous pouvez contrôler les stratégies utilisées pour fabriquer la pièce 
depuis la boite de dialogue propriétées.  

1 Ouvrir le volet Arbre de construction. 

2 Cliquer-droit sur perçage 1 sous le noeud Repère 1 et sélectionner 
l'option Propriétés. 

 
3 Dans la boite de dialogue Propriétés : 

 
a Sélectionner l'onglet Stratégie 
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b Désélectionner l'option Pointage 

c Cliquer sur OK. 

4 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. 

5 Dans la barre d'outils Simulation, cliquer sur le bouton Simulation 

3D , et ensuite cliquer sur Play  pour commencer la 
simulation. 

 Il n'y a pas de pointage de perçage pour le premier trou. 
Regarder la liste des opérations, il n'y a maintenant qu'une 
seule opération de pointage listée. FeatureCAM optimise le 
processus de fabrication mais vous contrôlez le niveau 
d'optimisation automatique. 

6 Cliquer sur Ejecter . Ceci efface la barre d'outils de simulation. 
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Génération du code CN (Fraisage 2,5D) 
FeatureCAM génère le code CN pour fabriquer des pièces sur une 
machine CNC. Vous pouvez générer le code CN après avoir simulé la 
pièce et par conséquent calculé les parcours.  

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur le bouton Programme CN  génère le Code CN. 
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Affectation des outils 
Pour modifier l'emplacement des outils dans le changeur d'outil : 

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur Affectation des outils  . Ceci affiche l'affectation 
des outils, indiquant l'ordre des outils.  

 
3 Pour déplacer le foret à centrer sur la 5ème position dans le 

changeur d'outil : 

a Sélectionner le premier outil de centrage dans le tableau. 

b Entrer un numéro d'outil de 5 dans le tableau. 

c Cliquer sur Définir. 

 Vous ne pouvez pas définir directement la valeur dans le 
tableau. 

4 Cliquer sur OK pour enregistrer les changements, et fermer la 
boite de dialogue Affectation des outils. 
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Changement de post-processeur 
Pour changer le post-processeur :  

1 Sélectionner Fabrication > Post-processeur depuis le menu. Cela 
afficher la boite de dialogue Options de post-processeur.  

2 Cliquer sur Parcourir pour voir les post-processeurs disponibles.  

Le dossier par défaut est ..FeatureCAM\Examples\Posts.  

3 Sélectionner votre post-processeur et cliquer sur Ouvrir.  

Le nouveau post-processeur est affiché dans le champ Fichier 
CNC.  

4 Cliquer sur OK pour quitter la boite de dialogue Options de 
post-processeur et utiliser le nouveau post-processeur, cliquer 
sur Annuler pour quitter la boite de dialogue et conserver le 
post-processeur original.  

5 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. 

6 Lancer une simulation de la pièce pour régénérer le code CN.  
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Enregistrement du code CN 
Pour enregistrer le programme CN : 

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur le bouton Enregister CN   dans la boîte de 
dialogue Code CN. 

3 Dans la boite de dialogue Enregistrer CN, accepter le nom par 
défaut et le dossier et cliquer sur OK. 
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Ce didacticiel vous montre comment créer une pièce de tournage 
simple, générer les parcours d'outils et extraire le parcours utilisé 
pour usiner la pièce. 

Pour utiliser l'exemple de tournage/fraisage, démarrer FeatureCAM 
(voir "Démarrage de FeatureCAM pour la première fois" sur la page 
2), créer un nouveau fichier (voir "Création d'un nouveau fichier" 
sur la page 5) avec un type de tournage/fraisage ou de tournage, puis 
suivre ces étapes :  

1 Création du brut (voir "Définition du brut (Tournage)" sur la page 
30). 

2 Etapes préparatoires (voir "Etapes préparatoires (Tournage)" sur 
la page 31). 

3 Définition de la géométrie (voir "Définition de la géométrie 
(Tournage)" sur la page 33).  

4 Création des features (voir "Création des features (Tournage)" 
sur la page 36). 

5 Affichage de la pièce (voir "Affichage de la pièce (Tournage)" sur 
la page 42). 

6 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (Tournage)" sur la page 45). 

7 Triage des opérations de fabrication (voir "Triage des opérations 
de fabrication (Tournage)" sur la page 46).  

8 Création de la documentation pièce (voir "Documentation de 
pièce (Tournage)" sur la page 50).  

9 Changement du post-processeur (voir "Changement de 
post-processeur" sur la page 27). 

10 Génération du code CN (voir "Génération du code CN 
(Tournage)" sur la page 51). 

11 Enregistrement du code CN (sur la page 27). 
 

Introduction au tournage 
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Définition du brut (Tournage) 
Le brut est la matière initiale, avec laquelle vous usinez votre pièce.  
Par défaut, l'assistant de brut (page Dimensions) s'ouvre sur l'écran 
dès que vous créez une nouvelle pièce. Elle vous permet de définir 
la forme et les dimensions du brut, la matière du brut, son origine 
programme et le système de coordonnées pour la modélisation. 

1 Sur la page Dimensions de l'assistant de brut : 

 
a Entrer un diamètre extérieur de 100mm.  

b Entrer une longueur de 125mm. 

c Entrer un diamètre intérieur de 0mm.  

d Depuis le bouton déroulant Terminer, sélectionner l'option 
Terminer et éditer les propriétés. 

 
Cela affiche la boite de dialogue des propriétés du brut. 
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2 Dans la boite de dialogue des propriétés du brut entrer un Z de 
1,5mm et cliquer sur OK. 
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Etapes préparatoires (Tournage) 
Les étapes préparatoires déterminent le système de coordonnées et 
l'armoire à outils. 

1 Sélectionner Options > Modes d'entrée de tournage > 3D (XYZ) 
depuis le menu pour permettre d'entrer les coordonnées en tant 
que valeurs de X, Y et Z. 

2 Sélectionner Fabrication > Définir l'armoire à outils dans le menu 
pour afficher la boite de dialogue Sélectionner l'armoire à outils 
active. 

3 Sélectionner l'option outils depuis la liste des armoires et cliquer 
sur OK. 

4 Pour afficher la pièce entièrement :   

a Cliquer sur le bouton Rotation  pour afficher le menu 
Affichage : 

 

b Cliquer sur Centrer tout . 
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Définition de la géométrie (Tournage) 
Ceci vous montre comment concevoir la pièce. 

 
1 Dessiner deux lignes : 

a Cliquer sur l'étape Géométrie  dans le volet Etapes.  

Cela affiche la boite de dialogue Constructeurs de géométrie. 

 
b Sélectionner l'option Multi-création et cliquer sur le bouton 

Ligne par 2 points  . Ceci affiche la barre d'outils d'édition de 
feature/géométrie. 

 
c Créer deux lignes qui définissent le profil extérieur, sur la 

barre Edition de feature/géométrie: 

Pour le point 1, entrer un XYZ 1 de X 50mm, Y 0, Z -88mm. 

Pour le point 2, entrer un XYZ 2 de X 25mm, Y 0, Z  -88mm. 
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Appuyer sur Entrée. Cela dessine une ligne dans la fenêtre 
graphique. 

 
d Créer une seconde ligne : 

Pour le point 1, entrer un XYZ 1 de X 25mm, Y 0, Z  -88mm. 

Pour le point 2, entrer un XYZ 2 de X 25mm, Y 0, Z 0. 

Appuyer sur Entrée pour créer une seconde ligne.  

 
2 Créer un chanfrein pour limiter vos lignes. 

a Cliquer sur l'étape Géométrie  dans le volet Etapes. 

b Dans la boite de dialogue Constructeurs de géométrie, dans la 
liste des options de Raccord cliquer sur le bouton Chanfrein 

 . 

c Sur la barre d'édition de feature/géométrie, entrer : 

une largeur de 6mm. 

une hauteur de 6mm. 

d Positionner le pointeur de votre souris près de l'emplacement 
du chanfrein. Le chanfrein est accroché en place. 
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e Cliquer pour placer le chanfrein sur votre dessin. Le chanfrein 
relimite automatiquement vos lignes. 

3 Pour tourner la pièce, vous devez convertir ces trois lignes 
individuelles en une seule courbe (chaîner la courbe).  

a Sélectionner Courbes  étape depuis le panneau Etapes. 

b Dans la boîte de dialogue Création de courbe, sélectionner le 

bouton Courbe fermée  . 

c Dans la fenêtre graphique, cliquer sur les positions ,  et 
. Chaque segment change de couleur quand il est 

sélectionné.  

 
d Sur la barre d'édition de feature/géométrie, nommer la courbe 

Tournage et appuyer sur Entrer. 

4 Créer une troisième ligne que vous pourrez utiliser pour créer 
une feature d'alésage. 

a Cliquer sur l'étape Géométrie  dans le volet Etapes. 

b Dans la boite de dialogue Constructeurs de géométrie, cliquer 
sur Ligne passant par deux points  . 

c Sur la barre d'édition de feature/géométrie : 

Pour le point 1 entrer un XYZ 1 de X  16mm, Y 0, Z 0. 

Pour le point 2, entrer un XYZ 2 de X  16mm ,  Y 0 , Z -94 
mm. 

d Appuyer sur Entrée. 

5 Pour chaîner la courbe d'alésage : 

a Sélectionner Courbes  étape depuis le panneau Etapes. 

b Dans la boîte de dialogue Création de courbe, sélectionner le 

bouton Courbe fermée  . 
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c Dans la fenêtre graphique, cliquer sur les positions 4 et 5 
(vous sélectionnez deux fois la ligne). 

 
d Sur la barre d'outils d'édition de feature/géométrie, nommer la 

courbe alésage et appuyer sur Entrée. 
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Création des features (Tournage) 
Cela vous montre comment créer les features de tournage.  

 

1 Sélectionner le bouton Profil de tournage 2D  , sur la barre 
d'outils de mode d'affichage, pour passer en représentation 2D 
simplifiée de la pièce.  

 

 Pour ouvrir la barre d'outils de mode d'affichage, 
sélectionner l'option de menu Affichage > Barre d'outils, 
sélectionner l'option Mode d'affichage, puis cliquer sur OK.  

1 Créer une feature de tournage 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 
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b Dans les documents de Tournage/Fraisage, l'assistant de 
nouvelle feature vous demande quel type de feature vous 
voulez créer. Sélectionner l'option Tournage et cliquer sur 
Suivant.  

 
c Sélectionner Tournage dans la section Depuis une courbe et 

cliquer sur Suivant.  

d Dans le champ Courbe, sélectionner tournage depuis la liste.  

Cliquer sur le bouton Choisir une courbe  pour sélectionner 
graphiquement la courbe. La boite de dialogue est minimisée 
pour afficher la fenêtre graphique en-dessous.  

Cliquer sur la courbe que vous avez nommé tournage, plus tôt.  

Dans ce cas particulier, deux éléments sont disponibles pour 
la sélection : une ligne et une courbe. A chaque fois que votre 
sélection doit être clarifiée, FeatureCAM ouvre la boite de 
dialogue Sélection.  

Dans la boite de dialogue Sélection, sélectionner tournage et 
cliquer sur OK.  
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e Depuis le bouton déroulant Terminer, sélectionner l'option 
Terminer et autre création pour continuer la création de 
features.  

 

 
2 Créer une feature de dressage 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 

b Dans le cadre Depuis dimensions, sélectionner Dressage et 
cliquer sur Suivant. 

c Sur la page Dimensions :  

Entrer une épaisseur de 1,5mm (0,0625 pouce).  

Entrer un diamètre extérieur de 100mm (4 pouces).  

Entrer un diamètre intérieur de 0.  
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Cliquer sur Suivant. 

d Cliquer sur Terminer et autre création. 

3 Créer une feature de perçage 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 

b Dans le cadre Depuis dimensions, sélectionner Perçage et 
cliquer sur Suivant. 

c Sur la page Dimensions : 

Entrer une profondeur de 94mm (3,75 pouces).  

Entrer un diamètre de 24mm (1 pouce).  

Cliquer sur Suivant. 

d Sur la page Emplacement, entrer un Z de 0.  

e Cliquer sur Terminer et autre création. 

 
4 Créer une feature d'alésage en utilisant le même processus que 

vous avez utilisé pour créer la feature de tournage. Utiliser la 
courbe nommée alésage.  

 
5 Créer une feature de gorge 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 
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b Dans le cadre Depuis dimensions, sélectionner Gorge et cliquer 
sur Suivant. 

c Sur la page Dimensions : 

Sélectionner une position interne.  

Sélectionner une orientation d'axe X.  

Entrer un diamètre de 31mm (1,25 pouces). 

Entrer une profondeur de 3mm (0,125 pouce). 

Entrer une largeur de 6mm (0,25 pouce).  

Laisser les autres réglages sur 0.  

Cliquer sur Suivant. 

d Sur la page Emplacement, entrer un Z de -75mm (-3 pouces).  

e Cliquer sur Terminer et autre création. 

 
6 Créer une feature de filetage. 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 

b Dans le cadre Depuis dimensions, sélectionner Filetage et 
cliquer sur Suivant. 

c Sur la page Dimensions :  

Sélectionner Filetage standard.  

Sélectionner Ext..  

Dans la champ Désignation, sélectionner M50-1,5 (2.000- 4.5 
UNC pour Impérial).  

Cliquer sur Suivant. 

d Sur la page Dimensions  : 

Sélectionner un filetage à droite.  

Entrer une longueur filetée de 25mm (1 pouce).  

Cliquer sur Suivant. 
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e Cliquer sur Terminer et autre création. 

 
7 Créer une feature de tronçonnage 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 

b Dans le cadre Depuis dimensions, sélectionner Tronçonnage et 
cliquer sur Suivant. 

c Sur la page Dimensions : 

Entrer un diamètre de 100mm (4 pouces). 

Entrer un diamètre intérieur de 0 . 

Entrer une largeur de 3mm (0,122 pouce). 

Cliquer sur Suivant. 

d Sur la page Emplacement, entrer un Z de -112mm (-4,5 pouces). 

e Cliquer sur Terminer. 
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Affichage de la pièce (Tournage) 
Vous avez travaillé dans une vue 2D. 

Pour regarder la pièce dans une orientation différente vous pouvez 
sélectionner une des vues prédéfinies. Ces options sont disponibles 
depuis la barre d'outils Standard : 

 
1 Pour retourner à une vue 3D de la pièce, cliquer sur Profils 2D de 

tournage  , sur la barre d'outils de mode d'affichage. 

2 Cliquer sur le bouton Vue isométrique  sur la barre d'outils 
standard. 

 
3 Ombrer la pièce. 

a Ouvrir le panneau Arbre de construction, et sélectionner 
alésage1 dans l'arborescence du Repère1. 

b Cliquer sur le bouton Ombrage de la sélection  dans la barre 
d'outils de mode d'affichage. 

c Sélectionner filetage1 dans le tableau Arbre de construction. 
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d Cliquer à nouveau sur le bouton Ombre de la sélection . 

 

4 Cliquer sur le bouton Ne plus ombrer la sélection  dans la barre 
d'outils de mode d'affichage pour revenir à la vue filaire du 
dessin. 
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Simulation du parcours d'outils 
(Tournage) 

Maintenant que vous avez créé des features, FeatureCAM va 
automatiquement : 

 sélectionner les outils et les opérations les plus appropriés,  

 recommander les techniques d'usinage,  

 calculer les vitesses et les avances,  

 générer les parcours d'outils et créer les codes CN. 

Pour voir le parcours simulé : 

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

 

2 Cliquer sur le bouton Simulation 3D , et ensuite cliquer sur le 
bouton Play  pour démarrer la simulation. Si la boite de 
dialogue Options de tri automatique apparaît, cliquer sur OK pour 
la fermer. Ceci accepte les options de tri par défaut. 

Cela affiche un rendu 3D du processus de coupe. Par défaut, la 
vue de 3/4 est montrée lors d'une coupe ou d'un perçage 
intérieur sur la pièce.  
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 Si la vue de 3/4 n'est pas affichée, sélectionner Options > 
Simulation > Brut cylindrique depuis le menu, et sélectionner 
l'option Vue 3/4 avec tournage int., enfin cliquer sur OK  
fermer la boite de dialogue. Cliquer sur le bouton Play  
sur la barre d'outils de simulation pour voir les 
changements. 

3 Cliquer sur le bouton Jusqu'à l'opération suivante  . Ceci affiche 
l'opération de dressage.  

4 Répéter l'étape 3 pour voir chaque opération jusqu'à ce que 
l'ensemble de la pièce soit usiné. 

5 Cliquer sur Ejecter . Cela efface la simulation.  
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Triage des opérations de fabrication 
(Tournage) 

L'onglet d'outil Liste opé., dans la fenêtre des résultats, affiche 
toutes les opérations qui sont converties en features. Un signe 
jaune d'avertissement  à côté d'une opération indique un 
problème potentiel sur cette opération. Dans ce cas, si vous voyez 
des avertissements ignorez-les. 

 
Vous pouvez contrôler le tri automatique des opérations en utilisant 
soit des règles, soit des templates d'opération. Le didacticiel de 
fraisage 2,5D se penche sur l'utilisation de règles (voir "Tri 
automatique des opérations" sur la page 17).  

Cette section change le tri automatique en modifiant le template 
d'opération de tournage.  

Pour modifier le template 

1 Sélectionner l'option Tri automatique dans l'onglet Liste opé. Cela 
s'assure que les règles de tri automatique soient appliquées aux 
opérations. 

2 Changer le tri automatique pour grouper les opérations qui 
utilisent le même outil. 

a Cliquer sur le bouton des options de tri  . 
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b Dans la boite dialogue Options de tri automatique, sélectionner 
Utiliser un template.  

 
c Cliquer sur Editer le template.  

3 Dans la boite de dialogue Ordre des features :  

 
a Sélectionner Ebauche tournage extérieur.  

b Cliquer sur  jusqu'à ce que Ebauche tournage extérieur se 
trouve en-dessous de Finition tournage extérieur.  

c Cliquer sur OK pour fermer la boite de dialogue Ordre des 
features.  

4 Cliquer sur OK pour fermer la boite de dialogue Options de tri 
automatique.  

5 Simuler la pièce. 

a Sélectionner l'étape Parcours d'outil  depuis le panneau 
Etapes. Cela affiche la barre d'outils de simulation. 
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b Cliquer sur le bouton de Simulation 3D , puis cliquer sur le 
bouton Play  pour démarrer la simulation. 

Remarquez que l'ébauche et la finition de tournage externe se 
produit maintenant après que le trou soit perçé.  

c Cliquer sur le bouton Stop   quand la simulation est 
terminée pour quitter le mode simulation. 
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Documentation de pièce (Tournage) 
Aussi bien que pour la simulation d'une pièce, la simulation génère 
aussi des listes complètes d'outils et d'opérations. Les outils 
sélectionnés sont basés sur votre base de données d'outils. Vous 
pouvez imprimer cette liste pour réaliser une vérification par 
l'opérateur. 

1 Cliquer sur l'onglet Détails dans la fenêtre Résultats pour afficher 
le panneau Détails de la fabrication. 

 
Vous pouvez consulter cette fiche en utilisant les barres de 
défilement. 

2 Sélectionner l'option Liste d'outils au dessus de l'onglet Détails 
pour afficher le panneau Résumé des outils d'usinage. Il contient 
tous les outils utilisés pour créer la pièce basé sur la bibliothèque 
que vous avez sélectionné. 

 Vous pouvez imprimer cette documentation depuis l'option 
menu Fichier > Imprimer. 
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Génération du code CN (Tournage) 
FeatureCAM génère le code CN pour fabriquer des pièces sur une 
machine CNC. Vous pouvez générer le code CN après avoir simulé la 
pièce et par conséquent calculé les parcours.  

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur le bouton Afficher le code CN  le bouton génère le 
code CN. 
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Changement de post-processeur 
Pour changer le post-processeur :  

1 Sélectionner Fabrication > Post-processeur depuis le menu. Cela 
afficher la boite de dialogue Options de post-processeur.  

2 Cliquer sur Parcourir pour voir les post-processeurs disponibles.  

Le dossier par défaut est ..FeatureCAM\Examples\Posts.  

3 Sélectionner votre post-processeur et cliquer sur Ouvrir.  

Le nouveau post-processeur est affiché dans le champ Fichier 
CNC.  

4 Cliquer sur OK pour quitter la boite de dialogue Options de 
post-processeur et utiliser le nouveau post-processeur, cliquer 
sur Annuler pour quitter la boite de dialogue et conserver le 
post-processeur original.  

5 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. 

6 Lancer une simulation de la pièce pour régénérer le code CN.  
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Enregistrement du code CN 
Pour enregistrer le programme CN : 

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur le bouton Enregister CN   dans la boîte de 
dialogue Code CN. 

3 Dans la boite de dialogue Enregistrer CN, accepter le nom par 
défaut et le dossier et cliquer sur OK. 
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Ce didacticiel aborde :  

 la création de pièces pour les tours avec capacités de fraisage.  

 le mélange de features de tournage et de fraisage.  

 la création de features de fraisage sur le diamètre extérieur et 
sur la pièce.  

 la simulation d'une pièce de tournage/fraisage.  

 Vous devez avoir l'option Turn/Mill licenciée pour lancer ce 
tutoriel.  

Pour utiliser l'exemple de tournage/fraisage, démarrer FeatureCAM 
(voir "Démarrage de FeatureCAM pour la première fois" sur la page 
2), créer un nouveau fichier (voir "Création d'un nouveau fichier" 
sur la page 5) avec un type de tournage/fraisage, puis suivre ces 
étapes : 

1 Etapes préparatoires (voir "Etapes préparatoires 
(Tournage/Fraisage)" sur la page 56). 

2 Définition de la géométrie (voir "Définition de la géométrie 
(Tournage/Fraisage)" sur la page 57). 

3 Création des features (voir "Création des features 
(Tournage/Fraisage)" sur la page 59). 

4 Affichage de la pièce (voir "Affichage de la pièce 
(Tournage/Fraisage)" sur la page 60). 

5 Création de trois perçages radiaux sur la face (voir "Création de 
trois trous radiaux sur la face" sur la page 62).  

6 Gravure sur la face (voir "Gravure de la face" sur la page 63).  

7 Création de trois fentes (sur la page 66).  

Introduction au 
tournage/fraisage 
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8 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (Tournage/Fraisage)" sur la page 68). 
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Etapes préparatoires 
(Tournage/Fraisage) 

Les étapes préparatoires définissent le brut et déterminent le 
système de coordonnées et la vue. 

1 Dans la page Dimensions de l'assistant de brut : 

 
a Sélectionner une forme cylindrique. 

b Entrer un diamètre extérieur de 76mm. 

c Entrer une longueur de 51. 

d Entrer un diamètre intérieur de 0. 

2 Cliquer sur Suivant jusqu'à ce que vous atteignez la page Origine 
du programme pièce.  

3 Sélectionner Aligner sur une face de brut. 

4 Cliquer sur Suivant. 

5 Cliquer sur  pour positionner le repère de la pièce.  

6 Depuis le bouton Terminer du menu sélectionner le bouton 
Terminer. 

7 Depuis le menu d'affichage , sélectionner Centrer tout .  

8 Sélectionner Options > Modes d'entrée de tournage > Diamètre (DZ) 
depuis le menu pour permettre d'entrer les coordonnées de 
diamètre et valeurs Z. 

 



 

Autodesk FeatureCAM 2017  Introduction au tournage/fraisage • 57  

Définition de la géométrie 
(Tournage/Fraisage) 

Ceci vous montre comment concevoir la pièce. 

 
1 Dessiner trois lignes : 

a Sélectionner l'étape Géométrie  depuis le panneau Etapes. 
Cela affiche la boite de dialogue Constructeurs de géométrie. 

 
b Sélectionner l'option Multi-création, et cliquer sur le bouton 

Multi-lignes  . Ceci montre la barre d'outils d'édition de 
feature/géométrie. 

c Pour créer deux lignes qui définissent le profil externe, sur la 
barre d'édition de feature/géométrie : 

Pour le point 1, entrer D/Z 1 de D 63,5mm, Z 0. 

Pour le point 2, entrer D/Z 2 de D 63,5mm, Z -38mm. 

Appuyer sur Entrée pour créer une ligne. 

d Créer une seconde ligne avec ces valeurs : 

Pour le point 2, entrer D/Z 2 de D 70mm, Z -38mm. 

Appuyer sur Entrée pour créer une seconde ligne. 

e Créer une troisième ligne avec les valeurs : 

Pour le point 2, entrer D/Z 2 de D 70mm, Z 51mm. 
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Appuyer sur Entrée pour créer une troisième ligne. 

 
2 Créer un raccord pour relimiter vos lignes. 

a Sélectionner l'étape Géométrie  depuis le panneau Etapes. 

b Dans la boite de dialogue Constructeurs de géométrie, dans la 
liste d'options Raccord cliquer sur le bouton Congé sur coin 

 . 

c Sur la barre d'édition de feature/géométrie, entrer un rayon (R) 
de 3mm. 

d Placer le pointeur de la souris dans le coin entre les première 
et deuxième lignes, puis cliquer dessus pour créer le congé. 
Le congé relimite automatiquement vos lignes. 

 
3 Pour tourner la pièce, vous avez besoin de chaîner les courbes.  

a Sélectionner Courbes  étape depuis le panneau Etapes. 

b Dans la boite de dialogue Création de courbe, sélectionner le 

bouton Courbe ouverte  . 

c Dans la fenêtre graphique, cliquer sur la première et la 
troisième ligne. 

d Sur la barre d'édition de feature/géométrie, nommer la courbe 
Tournage et appuyer sur Entrée. 
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Création des features 
(Tournage/Fraisage) 

Cet exemple vous montre comment créer des features de tournage. 

 

1 Cliquer sur le bouton Profils 2D de tournage  , dans la barre 
d'outils de mode d'affichage, pour passer à une représentation 3D 
de la pièce. 

2 Créer une feature Tournage. 

 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 

b Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage et cliquer sur Suivant. 

c Sélectionner Tournage dans la section Depuis une courbe et 
cliquer sur Suivant. 
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d Dans le champ Courbe sélectionner tournage depuis la liste. 

Cliquer sur le bouton Choisir courbe ou géométrie  pour 
sélectionner la courbe graphiquement. La boite de dialogue se 
réduit pour faire apparaître la fenêtre graphique au-dessous. 

Cliquer sur la courbe que vous avez nommée tournage un peu 
plus tôt. 

Dans la boite de dialogue de sélection, sélectionner tournage, 
et cliquer sur OK. 

e Cliquer sur Terminer. 
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Affichage de la pièce 
(Tournage/Fraisage) 

1 Sur la boite d'outils Standard sélectionner le bouton Vue 

isométrique  . 

 

 Si cela affiche est une représentation 2D de la pièce, cliquer 
sur le bouton Profils 2D de tournage  , sur la barre 
d'outils de mode d'affichage. 

2 Ombrer la pièce : 

a Ouvrir le panneau Arbre de construction, et sélectionner 
tournage1 sous le nœud Repère1. 

b Cliquer sur le bouton Ombrage sélectionné  dans la barre 
d'outils de mode d'affichage. 

 

c Cliquer sur le bouton Ne plus ombrer la sélection  dans la 
barre d'outils de mode d'affichage pour revenir à la vue filaire 
du dessin. 

3 Pour changer la vue à une vue de dessus, depuis le bouton du 
menu de la vue principale , cliquer sur le bouton Dessus .  
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Création de trois trous radiaux sur la 
face 

Cela vous montre comment ajouter trois trous à la pièce. 

 
1 Pour retourner à la vue 2D du modèle, cliquer sur le bouton 

Profils 2D de tournage  , sur la barre d'outils de mode 
d'affichage. 

 
2 Créer un perçage. 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 

b Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage/Fraisage et cliquer sur Suivant. 

c Dans la section Depuis dimensions, sélectionner Perçage et 
cliquer sur Suivant. 

d Dans la boite de dialogue Dimensions : 

Entrer un chanfrein de 0. 

Entrer une profondeur de 25mm. 

Entrer un diamètre de 6mm. 



 

Autodesk FeatureCAM 2017  Introduction au tournage/fraisage • 63  

e Cliquer sur Terminer et autre création. 

3 Créer un motif de la feature : 

a Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage/Fraisage et cliquer sur Suivant. 

b Dans le champ Depuis dimensions, sélectionner Motif et cliquer 
sur Suivant. 

c Sélectionner le perçage que vous venez de créer et cliquer sur 
Suivant. 

d Sélectionner Radial dans le plan XY du repère et cliquer sur 
Suivant. 

e Sur la page Motif - Dimensions : 

Entrer un nombre de 3. 

Entrer un diamètre de 51mm. 

Entrer un écart angulaire de 120°. 

Entrer un angle de 60°. 

f Cliquer sur Terminer. 

g Cliquer sur Annuler. 

4 Voir la représentation filaire 3D de la pièce : 

a Cliquer sur le bouton Profils 2D de tournage  , dans la barre 
d'outils de mode d'affichage, pour passer à une représentation 
3D de la pièce. 

b Cliquer sur le bouton Vue isométrique  sur la barre d'outils 
standard. 
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Gravure de la face 
Cela vous montre comment graver la pièce en : 

 créant du texte de gravure. 

 créant une feature de rainure. 

 
1 Créer une nouvelle courbe. 

a Sélectionner Courbes  étape depuis le panneau Etapes. 

b Dans la boite de dialogue Création de courbe, sélectionner le 

bouton Assistant de courbe . 

c Dans l'assistant Courbe : 

 
Sélectionner Autres méthodes que la méthode de construction. 

Sélectionner Texte comme étant le constructeur. 
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Cliquer sur Suivant. 

d Dans la page Gravure de texte, configurer les propriétés du 
texte. 

 
Entrer un texte de TURNMILL. 

Sélectionner un type de parcours de Ligne. 

Entrer la position de X 0.0, Y -1,14, Z 0,0. 

Entrer un angle de -90°. 

Depuis la liste de justification, sélectionner Centre. 

Entrer une échelle de X 10, Y 10. 

Cliquer sur le bouton Police pour afficher la boite de dialogue 
Police . 

Depuis la liste Police, sélectionner Machine Tool Gothic. 

Entrer une taille de 72. 

Cliquer sur OK pour fermer la boite de dialogue. 

e Cliquer sur Terminer pour fermer l'assistant. 

2 Créer une feature Gorge. 

a Sélectionner le texte TURNMILL (courbe1) dans la fenêtre 
graphique. 

b Cliquer sur l'étape Features  depuis le panneau Etapes. 

c Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage/Fraisage et cliquer sur Suivant. 

d Dans la section Depuis une courbe, sélectionner Rainure et 
cliquer sur Suivant. 
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e Sur la page Courbes, cliquer sur Suivant (si vous avez 
sélectionné le texte à l'étape 2a). 

f Sur la page Position, cliquer sur Suivant. 

g Dans la page Dimensions : 

Entrer une largeur de 1,5mm. 

Entrer une profondeur de 0,5mm. 

Sélectionner Face. 

Sélectionner Simple (Gravure). 

h Cliquer sur Terminer. 
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Création de trois fentes 
Cela vous montre comment ajouter trois fentes fraisées à la pièce. 

 
1 Créer une feature de fente : 

a Cliquer sur l'étape Features  depuis le panneau Etapes. 

b Dans l'assistant de nouvelle feature, sélectionner l'option 
Tournage/Fraisage et cliquer sur Suivant. 

c Dans la section Depuis dimensions, sélectionner Fente. 

Sélectionner Créer un motif depuis cette feature et cliquer sur 
Suivant.  

d Dans la page Dimensions : 

Entrer une longueur de 25mm. 

Entrer une largueur de 12,5mm. 

Entrer une profondeur de 6mm. 

Cliquer sur Suivant. 

e Sur la page Motifs sélectionner Radial autour de l'axe d'indexage 
et cliquer sur Suivant. 

f Sur la page Position : 

Entrer un angle B de 90. 

Entrer un rayon de 31mm. 

Entrer un Z de 6mm.  

Cliquer sur Suivant. 

g Dans la page Dimensions : 

Entrer un nombre de 3. 

Entrer un écart angulaire de 120. 

h Cliquer sur Terminer. 
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Simulation du parcours d'outils 
(Tournage/Fraisage) 

Pour voir le parcours d'outils simulé :  

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

2 Sélectionner un fichier CNC pour une machine qui supporte 
l'outillage mixte. Par exemple : 

..\Examples\Posts\TurnMill\Skeleton\skeleton-1-turret.cnc 

3 Cliquer sur le bouton de Simulation 3D , puis cliquer sur le 
bouton Play  pour démarrer la simulation. Si la boite de 
dialogue Options de tri automatique apparaît, cliquer sur OK pour 
la fermer. Ceci accepte les options de tri par défaut. 

 
Les parcours d'outils sont simulés, y compris les rotations de la 
pièce. 

4 Cliquer sur Ejecter . Ceci efface la barre d'outils de simulation. 
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Ce didacticiel aborde : 

 la modélisation de surfaces 3D.  

 la fabrication de surfaces en utilisant des features de fraisage 
surfacique.  

 la fabrication d'opérations 

 la sélection d'outils. 

 l'établissement des attributs de fabrication 3D.  

 Vous devez avoir 3D milling pour effectuer les exemples dans 
ce chapitre. Ces exemples sont spécifiés uniquement en 
unités impériales. Vous devez avoir installé l'armoire à outils 
basic.  

Ce didacticiel vous montre comment créer une pièce simple, 
générer les parcours d'outils et extraire le parcours utilisé pour 
usiner la pièce. 

Pour utiliser l'exemple de fraisage 3D, démarrer FeatureCAM (voir 
"Démarrage de FeatureCAM pour la première fois" sur la page 2), 
créer un nouveau fichier (voir "Création d'un nouveau fichier" sur la 
page 5), puis suivre ces étapes : 

1 Définition du brut (voir "Définition du brut (Fraisage 3D)" sur la 
page 71).  

2 Définition de la géométrie (voir "Définition de la géométrie 
(Fraisage 3D)" sur la page 72). 

3 Création de la surface de la bouteille (voir "Création de la surface 
d'une bouteille" sur la page 76).  

4 Affichage de la pièce (voir "Affichage de la pièce (Fraisage 3D)" 
sur la page 77). 

Introduction au fraisage 
3D 



 

70 • Introduction au fraisage 3D  Mise en route  

5 Création d'une feature de fraisage surfacique (sur la page 80).  

6 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (Fraisage 3D)" sur la page 84). 
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Définition du brut (Fraisage 3D) 
Le brut est la matière initiale, avec laquelle vous usinez votre pièce. 

1 Dans la page Dimensions de l'assistant de brut : 

 
a Entrer une épaisseur de 51mm 

b Entrer une largeur de 76mm 

c Entrer une longueur de 160mm 

d Cliquer sur Terminer 

2 Cliquer sur OK pour accepter les valeurs de la boite de dialogue 
de propriétés du brut. 
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Définition de la géométrie (Fraisage 3D) 
Ceci vous montre comment concevoir la pièce. 

 
1 Sélectionner Affichage > Barres d'outils depuis le menu, dans le 

cadre Barres d'outils : 

a Sélectionner Avancée. 

b Sélectionner Géométrie. 

c Cliquer sur OK. 

2 Créer trois lignes verticales : 

a Sur la barre d'outils Géométrie, sélectionner Verticale  
depuis le menu Ligne . 

 
b Sur la barre d'édition de feature/géométrie, entrer un XYZ de X 

25,5mm, Z 0 et appuyer sur Entrée. 

c Créer une deuxième ligne en entrant un XYZ de X 133,5mm, Z 
0 et appuyer sur Entrée. 

d Créer une troisième ligne en entrant un XYZ de X 152,5, Z 0 et 
appuyer sur Entrée. 

 
3 Créer trois lignes horizontales : 

a Sur la barre d'outils Géométrie, sélectionner Horizontale  
depuis le menu Ligne . 
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b Entrer un XYZ de Y 12,5mm, Z 0, et appuyer sur Entrée. 

c Créer une deuxième ligne en entrant un XYZ de Y 28,5mm, Z 
0, et appuyer sur Entrée. 

d Créer une troisième ligne en entrant un XYZ de Y 38mm, Z 0, 
et appuyer sur Entrée.  

 
4 Créer une ligne : 

a Sur la barre d'outils de géométrie, sélectionner Point, angle  
depuis le menu Ligne . 

b Sur la barre d'édition de feature/géométrie, entrer un angle A 
de 30. 

c Dans la fenêtre graphique, cliquer sur l'intersection entre la 
seconde ligne horizontale et la seconde verticale, au point , 
pour créer une ligne finie. 

 
5 Créer des arcs.  

a Sur la barre d'outils de géométrie, sélectionner 2 points, rayon 
 depuis le menu Arc . 
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b Sur la barre d'édition de feature/géométrie, entrer un rayon R 
de 12,5mm et cliquer sur la ligne verticale vers le point  et 
la ligne horizontale vers le point . 

 
c Créer un deuxième arc : 

Sur la barre d'édition de feature/géométrie, entrer un rayon R 
de 25,5mm et cliquer sur la ligne horizontale vers le point  
et l'extrémité de la ligne vers le point . 

 
d Créer le troisième arc en cliquant sur l'extrémité de la ligne 

vers le point  et la ligne horizontale vers le point . 

 
6 Pour fraiser la pièce, vous avez besoin de chaîner les courbes.  

a Sélectionner Courbes  étape depuis le panneau Etapes. 

b Dans la boîte de dialogue Création de courbe, sélectionner le 

bouton Courbe fermée  . 



 

Autodesk FeatureCAM 2017  Introduction au fraisage 3D • 75  

c Cliquer sur l'intersection de la ligne verticale et de la ligne 
horizontale au point  et à l'intersection de la ligne verticale 
et de la ligne horizontale au point . 
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Création de la surface d'une bouteille 

1 Sélectionner Surfaces  depuis le panneau Etapes. 

2 Dans l'assistant Surface, sélectionner Surface de révolution et 
cliquer sur suivant. 

 
3 Sur la page Surface de révolution : 

 
a Entrer un angle de départ de 0 

b Entrer un angle de fin de 180 

c FeatureCAM sélectionne automatiquement votre chaîne de 
courbes dans la sélection Courbe. 
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d Dans la sélection Axe, cliquer sur le bouton Choisir une ligne 
 et sélectionner la ligne horizontale autour du point . 

 
Cliquer sur Terminer. 
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Affichage de la pièce (Fraisage 3D) 
1 Pour changer la vue par une vue isométrique, cliquer sur le 

bouton Isométrique  de la barre d'outils Standard. 

 
2 Contrôler comment la pièce est affichée en utilisant les options 

d'affichage. 

a Sélectionner Options > Affichage dans le menu. Cela affiche la 
boite de dialogue Options d'affichage. 

b Sélectionner l'option Afficher frontière de surface uniquement et 
cliquer sur Appliquer. 

Ceci affiche les surfaces, selon leurs limitations de frontières 
et leurs boucles externes. Aucune ligne supplémentaire n'est 
dessinée à l'intérieur de la surface. Cela rend l'affichage des 
modèles de grande taille beaucoup plus rapide. 

c Désélectionner l'option Afficher frontière de surface uniquement 
et cliquer sur Appliquer. 

Ceci affiche les surfaces avec des lignes à l'intérieur de la 
surface. Cela aide l'affichage, mais pour les modèles larges, 
cela ralentit l'affichage de la pièce.  

d Entrer une finesse de surface filaire de 20 et cliquer sur 
Appliquer. 

Cela affiche les surfaces avec plus de lignes. Diminuer la 
valeur de finesse de surface augmente la qualité d'affichage, 
mais ralentit les graphismes. 

e Cliquer sur OK pour fermer la boite de dialogue. 

3 Depuis le menu Masquer  sur la barre d'outils avancée, 
cliquer sur Masquer toute la géométrie . 

4 Depuis le menu Afficher   sur la barre d'outils avancée, 
cliquer sur Afficher toutes les surfaces . 
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5 Cliquer sur le bouton Ombrage de la sélection  sur la barre 
d'outils Standard pour ombrer la pièce. 
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Création d'une feature de fraisage 
surfacique 

Cela vous montre comment créer les features de fraisage 
surfacique. Ensuite, vous générez des parcours d'outils pour 
plusieurs surfaces en utilisant un certain nombre de parcours 
d'outils 3D. 

1 Sur la barre d'outils Standard, cliquer sur le bouton Sélection  
et sélectionner la surface (srf1). Lors de la sélection elle vire au 
rouge. 

 

2 Sélectionner la Feature  étape depuis le panneau Etapes. 
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3 Dans l'assistant de nouvelle feature, dans la section Depuis une 
surface, sélectionner l'option Fraisage surfacique et cliquer sur 
Suivant. 

 
4 Sur la page Surfaces de pièce, cliquer sur Suivant. 

5 Sur la page Nouvelle stratégie, sélectionner Choisir les opérations 
d'ébauche, de semi-finition et de finition et cliquer sur Suivant. 
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6 Sur la page Ebauche : 

 
a Sélectionner l'option Ebauche Tranche-Z. 

b Sélectionner Classification tranches -> Poche 3D. 

c Cliquer sur Suivant. 

7 Sur la page Semi-Fintion, sélectionner Aucune et cliquer sur 
Suivant. 
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8 Sur la page Finition sélectionner Isoligne. 

 
9 Cliquer sur le bouton Terminer. 
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Simulation du parcours d'outils 
(Fraisage 3D) 

Pour voir le parcours simulé : 

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

2 Cliquer sur le bouton Simulation 3D  et cliquer ensuite sur le 
bouton Play  pour démarrer la simulation. Si la boite de 
dialogue Options de tri automatique apparaît, cliquer sur OK pour 
la fermer. Ceci accepte les options de tri par défaut. 

 

 Remarquez comment les parcours d'outils sont simulés, y 
compris les rotations de la pièce. 

3 Cliquer sur Ejecter . Ceci efface la barre d'outils de simulation. 
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Ce didacticiel vous introduit aux principes de base de la création de 
parcours d'outils d'électro-érosion à fil. Il aborde :  

 la définition de la matière et de l'épaisseur de votre fil.  

 la création de features d'électro-érosion à fil.  

 la spécification d'une stratégie de coupe d'électro-érosion.  

 la simulation de parcours d'outils d'électro-érosion à fil.  

 Vous devez avoir licencié l'option Wire EDM pour lancer ce 
tutoriel.  

  

Pour utiliser l'exemple d'électro-érosion à fil, démarrer FeatureCAM 
(voir "Démarrage de FeatureCAM pour la première fois" sur la page 
2), créer un nouveau fichier (voir "Création d'un nouveau fichier" 
sur la page 5) avec un type d'électro-érosion, puis suivre ces étapes 
:  

1 Définition du brut (voir "Définition du brut (Electro-érosion)" sur 
la page 86).  

2 Création du profil (sur la page 87).  

3 Création d'une feature d'électro-érosion (sur la page 88).  

4 Simulation du parcours d'outils d'électro-érosion (voir 
"Simulation du parcours d'électro-érosion" sur la page 90).  

5 Génération du code CN (Electro-érosion à fil) (voir "Génération 
du code CN (Electro-érosion)" sur la page 93).  

6 Ajout d'un angle de dépouille (sur la page 94).  
 

Introduction à 
l'électro-érosion à fil 
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Définition du brut (Electro-érosion) 
Les étapes préparatoires définissent le brut et déterminent le 
système de coordonnées et la vue. 

1 Dans la page Dimensions de l'assistant de brut : 

 
a Entrer une épaisseur de 12mm 

b Entrer une largeur de 100mm 

c Entrer une longueur de 100mm 

d Cliquer sur le bouton Terminer.  
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Création du profil 
Cette étape définit le profil.  

 

1 Sélectionner Courbes  étape depuis le panneau Etapes. 

2 Dans la boite de dialogue Création de courbe, sélectionner le 

bouton Assistant de courbe . 

3 Dans l'assistant de courbe :  

 
a Sélectionner une méthode de construction dans Autres 

méthodes.  

b Sélectionner le constructeur de rectangle.  
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4 Cliquer sur Suivant. Sur la page Rectangle :  

 
a Sélectionner Util. coin, largeur, hauteur.  

b Entrer un point de coin à 25, 25 ,0.  

c Entrer un rayon de coin de 12,5.  

d Entrer une largeur de 50 

e Entrer une hauteur de 50.  

f Cliquer sur Terminer. 
 

Création d'une feature 
d'électro-érosion 

Cela vous montre comment créer une feature électro-érosion à fil. 

1 Cliquer sur l'étape Features  depuis le panneau Etapes. 
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2 Dans l'assistant de nouvelle feature, sélectionner Matrice dans la 
section 2 axes et cliquer sur Suivant. 

 
3 Dans la page Courbes, cliquer sur Choisir une courbe ou géométrie 

 et sélectionner la courbe que vous venez de créer et cliquer 
sur Suivant. 

 
4 Sur la page Position, cliquer sur Suivant. 

5 Sur la page Dimensions , entrer une épaisseur de 0.5 et cliquer 
sur Suivant. 

6 Sur la page Début, cliquer sur Suivant. 
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7 Sur la page Stratégies : 

 
a Dans le champ Opérations sélectionner Retrait. 

b Sélectionner l'option Coupe-chute. 

c Sélectionner l'option Contour 

d Cliquer sur Terminer. 
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Simulation du parcours 
d'électro-érosion 

Maintenant que vous avez créé des features, FeatureCAM va 
automatiquement : 

 sélectionner les outils et les opérations les plus appropriés,  

 recommander les techniques d'usinage,  

 calculer les vitesses et les avances,  

 générer les parcours d'outils et créer les codes CN. 

Pour voir le parcours simulé : 

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

 

2 Cliquer sur le bouton Simulation 2D  sur la barre d'outils de 
simulation. 

3 Centrer le curseur de vitesse de simulation   pour spécifier 
l'avance de simulation.  

4 Depuis le bouton de menu Jusqu'au suivant , sélectionner le 
bouton Jusqu'à l'opération suivante  pour voir l'opération de 
retrait. Si la boite de dialogue Options de tri automatique apparaît, 
cliquer sur OK pour la fermer.  



 

92 • Introduction à l'électro-érosion à fil  Mise en route  

 Pour ralentir la simulation, faire glisser le curseur de vitesse 
de simulation   vers la gauche.  

 

5 Cliquer à nouveau sur le bouton Jusqu'à l'opération suivante  
pour voir l'opération de coupe-chute.  
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6 Cliquer à nouveau sur le bouton Jusqu'à l'opération suivante  
pour voir l'opération de contournage finale.  

 

7 Cliquer sur Ejecter . 
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Génération du code CN 
(Electro-érosion) 

FeatureCAM génère le code CN pour fabriquer des pièces sur une 
machine CNC. Vous pouvez générer le code CN après avoir simulé la 
pièce et par conséquent calculé les parcours.  

1 Sélectionner l'étape Code CN  à partir du panneau Etapes. 
Ceci affiche la boite de dialogue Code CN. 

2 Cliquer sur le bouton Voir le code CN  génère le Code CN. 
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Ajout d'un angle de dépouille 
Cet exemple vous montre comment ajouter un angle de dépouille 
sur une pièce d'électro-érosion à fil. 

 
1 Ouvrir le volet Arbre de construction, sélectionner la feature 

Matrice1 depuis l'arborescence du Repère1 et cliquer sur le 

bouton Propriétés  sur la barre d'édition de feature/géométrie. 

2 Dans la boite de dialogue des propriétés de matrice1 : 

 
a Sélectionner Constante. 
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b Sélectionner un type de dépouille à gauche. 

c Entrer un angle de 10 pour l'angle de dépouille. 

d Cliquer sur Appliquer 

3 Cliquer sur le bouton Cacher le brut  depuis le menu cacher 
 sur la barre d'outils Avancée. 

 

4 Cliquer sur le bouton Vue isométrique  sur la barre d'outils 
Standard. 

 
5 Retourner à la boite de dialogue de propriétés, définir le type de 

dépouille sur Droite et cliquer sur Appliquer. 

 
6 Puis changer le type de dépouille, pour le ramener à gauche et 

cliquer sur OK pour fermer la boite de dialogue de propriétés. 

7 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. 

8 Cliquer sur le bouton Simulation 3D , puis cliquer sur le bouton 
Play .  
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9 Cliquer sur le bouton Sélect.  sur la barre d'outils Standard. 

10 Cliquer dans la courbe. FeatureCAM supprime cette partie du 
brut. 

 

11 Cliquer sur Ejecter . 

12 Depuis le menu Afficher  de la barre d'outils Avancée, cliquer 
sur le bouton Afficher le brut . 
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Il y a deux types de reconnaissance de feature dans FeatureCAM, 
que vous pouvez approfondir avec les exemples suivants :  

 Reconnaissance automatique de feature (voir "Exemple de 
reconnaissance automatique de feature" sur la page 99) — 
Reconnaître automatiquement toutes les features dans un 
modèle solide.  

 Reconnaissance interactive de feature (voir "Exemple de 
reconnaissance interactive de feature" sur la page 105) — 
Reconnaître des features individuelles à partir d'un modèle 
solide.  

 

Introduction à la 
reconnaissance de 
feature 
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Exemple de reconnaissance 
automatique de feature 

Cet exemple vous montre comment utiliser la reconnaissance 
automatique de feature pour reconnaître des features dans un 
modèle solide.  

Pour utiliser l'exemple de reconnaissance automatique de feature, 
démarrer FeatureCAM (voir "Démarrage de FeatureCAM pour la 
première fois" sur la page 2), créer un nouveau fichier (voir 
"Création d'un nouveau fichier" sur la page 5), puis suivre ces 
étapes :  

1 Importation du modèle solide (sur la page 100) : ug_plate.x_t. 

2 Utilisation de la reconnaissance automatique de feature (sur la 
page 102) pour créer les features.  

3 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (RAF)" sur la page 104). 
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Importation du modèle solide 
Cet étape vous montre comment importer un modèle solide dans 
FeatureCAM.  

Pour importer le modèle solide :  

1 Si la boite de dialogue Dimensions est affichée, cliquer sur 
Annuler pour la fermer.  

2 Sélectionner l'option de menu Fichier > Importer pour afficher la 
boite de dialogue Importer.  

3 Naviguer vers le dossier 
\FeatureCAM\Examples\FeatureRECOGNITION. 

4 Sélectionner le fichier ug_plate.x_t et cliquer sur Ouvrir. 

La boite de dialogue des résultats d'importation est affichée.  

5 Sélectionner Utiliser l'assistant pour définir l'origine du repère et les 
dimensions du brut et cliquer sur Suivant.  

La page Choix de la direction Z du repère est affichée.  

6 Cliquer sur Suivant. 

La page Choix de l'orientation X du repère initial est affichée. 

7 Cliquer sur Suivant. 

La page Forme de brut est affichée. 

8 Sélectionner Bloc et cliquer sur Suivant. 

La page Dimensions du brut est affichée.  

9 Sélectionner Calcul du brut à partir des dimensions de la pièce et 
cliquer sur Suivant.  

La page Choix de la position XYZ du repère initial est affichée.  

10 Cliquer sur  LL.  

Cela positionne le repère (l'origine du système de coordonnées 
de la pièce sur la machine) dans le coin inférieur gauche du brut.  

11 Cliquer sur Terminer pour fermer l'assistant. 

La pièce est importée dans le document.  



 

Autodesk FeatureCAM 2017  Introduction à la reconnaissance de feature • 101  

12 Appuyer sur les touches Ctrl+1 pour sélectionner une vue 
isométrique.  

 

 Vous pouvez en apprendre d'avantage à propos des options 
disponibles dans l'assistant d'importation en cliquant sur le 
bouton d'aide sur chaque page. 
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Utilisation de la reconnaissance automatique de feature 
Cette étape vous montre comment utiliser la reconnaissance 
automatique de feature pour créer des features.  

Pour utiliser la reconnaissance automatique de feature :  

1 Sélectionner l'option de menu Construction > Reconnaissance 
automatique de feature.  

La boite de dialogue Reconnaissance automatique de feature est 
affichée.  

2 Sélectionner votre solide importé dans la liste.  

3 Cliquer sur Options.  

La boite de dialogue Options de reconnaissance automatique.  

4 Dans la boite de dialogue des options de reconnaissance 
automatique :  

a Sélectionner Créer une feature de surfaçage 

b Sélectionner Créer motif de perçage 

c Désélectionner Créer feature 3D 

5 Cliquer sur OK pour fermer la boite de dialogue des options de 
reconnaissance automatique. 

6 Cliquer sur Suivant. 

La page de repères est affichée. Vous pouvez utiliser cette page 
pour sélectionner sur quels repères les features reconnues sont 
créées. Dans cet exemple, il n'y a qu'un repère.  

7 Cliquer sur Suivant. 

La page de features est affichée. Un liste de toutes les features 
reconnues est affichée et un aperçu filaire est affiché dans la 
fenêtre graphique.  

 
Vous pouvez désélectionner des features, dans la liste, que vous 
ne voulez pas créer. Dans ce didacticiel, vous n'avez pas besoin 
de créer de feature de surfaçage.  
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8 Désélectionner surfaçage 01 de la liste.  

9 Cliquer sur Terminer pour créer les features sélectionnées.  

Les features créées sont affichées dans l'arbre de construction.  

 
Vous pouvez déplacer le curseur sur le nom d'un élément dans 
l'arbre de construction pour le mettre en évidence dans la fenêtre 
graphique.  
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Simulation du parcours d'outils (RAF) 
Vous pouvez maintenant simuler les parcours d'outils pour voir les 
résultats de la reconnaissance de feature.  

Pour simuler les parcours d'outils :  

1 Sélectionner l'étape Parcours d'outils  à partir du panneau 
Etapes. Ceci affiche la barre d'outils Simulation . 

Cliquer sur le bouton Simulation 3D , et ensuite cliquer sur le 
bouton Play  pour démarrer la simulation. Si la boite de 
dialogue Options de tri automatique apparaît, cliquer sur OK pour 
la fermer. Ceci accepte les options de tri par défaut. 

La simulation d'usinage 3D est affichée dans la fenêtre 
graphique.  

 
S'il y a une collision, la simulation se met en pause et un 
avertissement est affiché.  

2 Quand la simulation est terminée, vérifier la pièce pour s'assurer 
qu'il n'y a pas d'entaille et que toutes les features usinées 
correctement.  

3 Sur la barre d'outils de simulation, cliquer sur Stop  pour 
effacer la simulation.  
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Exemple de reconnaissance interactive 
de feature 

Cet exemple vous montre comment utiliser la reconnaissance 
interactive de feature pour reconnaître des features dans un modèle 
solide. 

Pour utiliser l'exemple de reconnaissance interactive de feature, 
démarrer FeatureCAM (voir "Démarrage de FeatureCAM pour la 
première fois" sur la page 2), créer un nouveau fichier (voir 
"Création d'un nouveau fichier" sur la page 5), puis suivre ces 
étapes : 

1 Importation du modèle solide (sur la page 106) : Integrex.sat.  

2 Utilisation de la reconnaissance interactive de feature (sur la 
page 108) pour créer les features.  

3 Changement de la sélection d'outil (voir "Sélection d'outil (RIF)" 
sur la page 111).  

4 Simulation du parcours d'outils (voir "Simulation du parcours 
d'outils (RIF)" sur la page 113). 
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Importation du modèle solide 
Cet étape vous montre comment importer un modèle solide dans 
FeatureCAM.  

Pour importer le modèle solide :  

1 Si la boite de dialogue Dimensions est affichée, cliquer sur 
Annuler pour la fermer.  

2 Sélectionner l'option de menu Fichier > Importer pour afficher la 
boite de dialogue Importer.  

3 Naviguer vers le dossier 
\FeatureCAM\Examples\FeatureRECOGNITION. 

4 Sélectionner le fichier Integrex.sat et cliquer sur Ouvrir. 

La boite de dialogue des résultats d'importation est affichée. 

5 Sélectionner Utiliser l'assistant pour définir l'origine du repère et les 
dimensions du brut.  

6 Cliquer sur Suivant. 

La page Choix de la direction Z du repère est affichée. 

7 Cliquer sur Suivant. 

La page Choix de l'orientation X du repère initial est affichée. 

8 Cliquer sur Suivant. 

La page Forme de brut est affichée. 

9 Sélectionner Bloc et cliquer sur Suivant. 

La page Dimensions du brut est affichée.  

10 Sélectionner Calcul du brut à partir des dimensions de la pièce et 
cliquer sur Suivant.  

La page Choix de la position XYZ du repère initial est affichée.  

11 Cliquer sur  LL.  

Cela positionne le repère (l'origine du système de coordonnées 
de la pièce sur la machine) dans le coin inférieur gauche du brut.  

12 Cliquer sur Terminer pour fermer l'assistant. 

La pièce est importée dans le document. 
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13 Appuyer sur les touches Ctrl+3 pour sélectionner une vue 
isométrique. 

 

 Vous pouvez en apprendre d'avantage à propos des options 
disponibles dans l'assistant d'importation en cliquant sur le 
bouton d'aide sur chaque page. 
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Utilisation de la reconnaissance interactive de feature 
Cette étape vous montre comment utiliser la reconnaissance 
interactive de feature pour créer des features. Dans cet exemple, 
vous allez créer des features de contournage, puis des features de 
perçage.  

Création des features de contournage 

Pour créer les features de contournage :  

1 Cliquer sur l'étape Features   dans le volet Etapes. 

La boite de dialogue Nouvelle feature est affiché. 

2 Dans la section Depuis une courbe, sélectionner Contournage.  

3 Sélectionner Extraire et reconnaître les features. 

4 Cliquer sur Suivant. 

La page Extraction de feature est affichée.  

5 Sélectionner Sélect. surfaces latérales et cliquer sur Suivant. 

La page Surface est affichée.  

6 Dans la fenêtre graphique, sélectionner la surface sur laquelle 
créer la feature de contournage plane.  

 
7 Sur la page Surfaces, cliquer sur Ajouter depuis les éléments 

sélectionnés  pour ajouter la surface dans la liste.  

8 Cliquer sur la flèche sur le bouton Terminer, puis cliquer sur 
Terminer et autre création.  
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La feature est créée et la boite de dialogue Nouvelle feature est 
affiché. 

9 S'assurer que Contournage et Extraire et reconnaître les fetaures 
sont sélectionné, puis cliquer sur Suivant. 

La page Extraction de feature est affichée. 

10 Sélectionner Sélect. surfaces latérales et cliquer sur Suivant. 

La page Surface est affichée. 

11 Dans la fenêtre graphique, sélectionner les surfaces sur 
lesquelles créer les features de contournage incurvées, sur 
l'avant et l'arrière de la pièce.  

Avant :  

 
Arrière :  

 

 Maintenir la touche Maj et cliquer pour sélectionner 
plusieurs surfaces.  

 Appuyer sur Ctrl+3 ou Ctrl+7 pour sélectionner les vues 
isométriques avant et arrière.  
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12 Sur la page Surfaces, cliquer sur Ajouter depuis les éléments 
sélectionnés  pour ajouter les surfaces dans la liste. 

13 Cliquer sur la flèche sur le bouton Terminer, puis cliquer sur 
Terminer pour créer les features et fermer la boite de dialogue.  

Création des features de perçage 

Pour créer les features de perçage :  

1 Cliquer sur l'étape Features   dans le volet Etapes. 

La boite de dialogue Nouvelle feature est affiché. 

2 Dans la section Depuis dimensions, sélectionner Perçage.  

3 S'assurer que l'option Extraire et reconnaître les features est 
sélectionnée.  

4 Cliquer sur Suivant. 

La page Méthode de reconnaissance de perçage est affichée.  

5 Sélectionner Reconnaître et construire plusieurs perçages et cliquer 
sur Suivant.  

Un aperçu des perçages reconnus est affiché dans la fenêtre 
graphique.  

 
Vous pouvez maintenant sélectionner les perçages que vous 
voulez créer. Les perçages sélectionnés sont affichés en rouge.  

6 Cliquer sur Sélectionner tout pour sélectionner tous les perçages 
reconnus.  

7 Cliquer sur Terminer pour créer les features de perçage et fermer 
la boite de dialogue.  
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Sélection d'outil (RIF) 
Quand vous utilisez la reconnaissance de feature, il est possible de 
créer des features dont vous ne possédez pas les outils pour 
l'usiner.  

Dans cet exemple, il n'y a aucun outil qui ne répond aux exigences 
du perçage des grands trous. Si vous essayez de lancer une 
simulation, le message d'échec de génération du code est affiché.  

Quand cela se produit, vous pouvez :  

 ajouter un nouvel outil dans votre armoire qui est de la bonne 
taille pour usiner la feature, ou  

 usiner la feature avec un outil existant.  

Dans cet exemple, vous utiliserez un outil existant.  

Pour sélectionner un outil pour usiner la feature :  

1 Dans la fenêtre de résultats, sélectionner l'onglet Liste opé.  

La liste des opérations est affichée. Les opérations sans outil 
sélectionné ont un point d'exclamation rouge et aucun nom 
d'outil.  

 
2 Double-cliquer sur une opération sans outil pour afficher la boite 

de dialogue des propriétés de la feature.  

3 Sélectionner l'onglet Outils.  

Une liste des outils disponibles est affichée. 
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4 Cocher la case à côté d'un outil, comme TD_M1000:T, pour utiliser 
cet outil.  

 
5 Cliquer sur OK pour accepter vos changements et fermer la boite 

de dialogue. 

Parce que des features de perçage similaires sont créées en tant 
que motifs au lieu qu'elles le soient en tant que  features 
individuelles, vous n'avez à éditer qu'une seule feature et vos 
changements seront appliqués à toutes les features dans le 
motif.  

 La tolérance de sélection d'outil est déterminée par l'option 
Tolérance diamètre outil dans l'onglet de sélection d'outil de la 
boite de dialogue des attributs d'usinage. Vous pouvez 
augmenter cette valeur pour permettre à une plus large 
gamme d'outils d'être sélectionnée pour usiner une feature. 
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Simulation du parcours d'outils (RIF) 
Vous pouvez lancer une simulation 3D pour vérifier que les features 
ont été créées correctement et pour vérifier les collisions.  

1 Sélectionner l'étape Parcours d'outils  depuis le volet Étapes. 
Cela affiche la barre d'outils de simulation. 

2 Sur la barre d'outils de simulation, sélectionner l'option Simulation 

3D , puis cliquer sur Play  pour démarrer la simulation.  

Si la boite de dialogue d'options de tri automatique apparaît, 
cliquer sur OK pour la fermer. Ceci accepte les options de tri par 
défaut. 

La simulation d'usinage 3D est affichée dans la fenêtre 
graphique. 

 

3 Cliquer sur Stop  pour effacer les résultats de la simulation.  
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Feature gorge - 36 
Feature poche - 10 
Feature rainure - 64 
Feature tournage - 36, 57 
Feature tronçonnage - 36 
Feature trou - 10, 36, 59 
Fenêtre de résultats - 17, 18, 20, 21, 45, 

48 
Fenêtres 

Fenêtre de résultats - 17, 18, 20, 21, 
45, 48 

Finition - 76 
Fraisage 

Feature fraisage de surface - 76 
Fraisage 2,5D - 9 
Fraisage 3D - 66 

Fraisage 2,5D - 9 
Fraisage 3D - 66 
Fraisage/Tournage - 52 

G 
Géométrie 

Cacher toute la Géométrie - 74 
Montrer toutes les Surfaces - 74 

Gravure - 61 

L 
La simulation de parcours d'outil 3D - 

15, 44, 65, 80, 86 
Liens pour l'aide - 7 
Ligne - 32, 55, 69 
Liste de contrôle - 21 
Liste de contrôle d'un opérateur - 21 
Liste des opérations - 21 
Liste des outils - 21 

M 
Mode d'affichage de la barre d'outil - 36 

Contour tourné 2D - 36, 57, 58 
Modèle 

Modèle d'opération - 45 
Modèle d'opération - 45 
Modes d'entrée - 31, 54 
Montrer toutes les Surfaces - 74 

O 
Ombrage - 41, 58, 74 
Opérations - 17, 45 

Contrôle des opérations - 22 
Contrôle des stratégies - 22 
Modèle d'opération - 45 
Options de tri - 18, 45 
Tri automatique - 18, 45 
Tri manuel - 20 

Opérations de fabrication - 17, 45 
Contrôle des opérations - 22 
Contrôle des stratégies - 22 
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Ébauche - 76 
Fenêtre de résultats - 17, 18, 20, 21, 
45, 48 
Finition - 76 
Modèle d'opération - 45 
Options de tri - 18, 45 
Semi finition - 76 
Tri automatique - 18, 45 
Tri manuel - 20 

Opérations d'usinage - 17, 45 
Contrôle des opérations - 22 
Contrôle des stratégies - 22 
Ébauche - 76 
Fenêtre de résultats - 17, 18, 20, 21, 
45, 48 
Finition - 76 
Modèle d'opération - 45 
Options de tri - 18, 45 
Semi finition - 76 
Tri automatique - 18, 45 
Tri manuel - 20 

Options de tri - 18, 45 
Outils 

Affectation des outils - 26 
Base de données outil - 2 
Outils en pouces - 2 
Outils impériale - 2 
Outils utilisant le système métrique - 
2 

Outils en pouces - 2 
Outils impériale - 2 
Outils utilisant le système métrique - 2 
Ouvrir une pièce - 5 

P 
Parcours d'outil 

Simulation du parcours d'outil - 15, 
44, 65, 80, 86 

Pièce 
Ouvrir une pièce - 5 

Post processeur - 27 
pouces - 5 

R 
Raccord - 55 
Repère 

pouces - 5 

Repère fraisage - 5 
Unités impériale - 5 
Unités métrique - 5 

Repère fraisage - 5 

S 
Semi finition - 76 
Simulation du parcours d'outil - 15, 44, 

65, 80, 86 
La simulation de parcours d'outil 3D - 
15, 44, 65, 80, 86 

Stratégie 
Contrôle des stratégies - 22 
Options de tri - 18, 45 
Tri automatique - 18, 45 
Tri des opérations. - 17, 45 
Tri manuel - 20 

Support technique - 7 
Surface de Révolution - 73 
Système de Coordonnées - 31, 54 

T 
Texte - 61 
Tournage - 29 
Tournage/Fraisage - 52 
Tri automatique - 18, 45 
Tri des opérations. - 17, 45 

Contrôle des opérations - 22 
Contrôle des stratégies - 22 
Modèle d'opération - 45 
Options de tri - 18, 45 
Tri automatique - 18, 45 
Tri manuel - 20 

Tri manuel - 20 

U 
Unités 

Outils en pouces - 2 
Outils impériale - 2 
Outils utilisant le système métrique - 
2 
pouces - 5 
Unités impériale - 5 
Unités métrique - 5 

Unités impériale - 5 
Unités métrique - 5 
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V 
Vue de face - 14 
Vue isométrique - 14, 41, 58, 74 
Vues 

Affichage de la pièce - 14, 41, 58, 74 
Centrer tout - 31, 54 
Contour tourné 2D - 36, 57, 58 
Vue de face - 14 
Vue isométrique - 14, 41, 58, 74 

Z 
Zone de garde 

Ébauche - 76 

 


